
Pg. 1 of 15 

WORKSTATION OPERATIONS 
 
START UP DIRECTIONS FOR TERMINALS 

1. Connect communications cables 
2. Connect power cables (a beep should sound from the scanner) 
3. Press down and release the power switch on the lower-right underside of the screen (another beep will sound from 

the terminal) 
4. The computer will go through the startup process, wait for “SERVER #:” to appear with the number pad. 

 
SHUT DOWN DIRECTIONS 
Simply press the power switch on the underside of the screen again.  The computer will go through the shutdown process 
and power itself off.  If it does not do this (i.e. it is locked up), hold the power switch down, and the computer will shut down 
after about 10 seconds. 
 
SIGN ON 
      -     Enter your workstation number (1, 2, 3, etc.) and press “ENTER” 
 
CASH SALE WITH CHANGE COMPUTATION 

1. Ring items 
2. Press “CASH” 
3. Enter the amount tendered and press “ENTER” 
4. Press “OK” 

 
CASH SALE WITHOUT CHANGE COMPUTATION 
(This is the procedure to use if the student has exect change) 

1. Ring items 
2. Press “CASH” 
3. Press “ENTER” 

 
CASH SALE USING PRESET TENDER 

1. Ring items 
2. Press the preset tender key ($5.00, $10.00, $20.00) 
3. Press “OK” 

 
CASH SALE USING “NEXT DOLLAR” 
Example: Sale total is $3.45 and student gives you $4.00 

1. Ring items 
2. Press “NEXT $” (change of $0.55 will display) 
3. Press “OK” 

 
OPEN THE CASH DRAWER WITHOUT RINGING A SALE 
      -     Press “NO SALE” 
 
STUDENT CHARGE 

1. Take card from student 
2. Scan card 
3. Ring items 
4. Press “CARD” 
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FACULTY CHARGE (Discount will be applied automatically if account is flagged in the back office) 
1. Take card from faculty member 
2. Scan card 
3. Ring items 
4. Press “CARD” 

 
FACULTY CASH TRANSACTION (Discount must be applied manually) 

1. Ring items 
2. Press “FACULTY” (top of screen) 
3. Finalize cash sale 

 
ORDER MULTIPLE OF THE SAME ITEM 

1. Enter the quantity on the vertical number bar 
2. Press the menu item 

 
MULTIPLY THE LAST ITEM RUNG (it will have a green background) 
      -     Press “ADD” 
 
MUTIPLY PREVIOUSLY RUNG ITEMS 

1. Highlight the item (it will now have a green background) 
2. Press “ADD” 

 
VOID THE LAST ITEM RUNG 
      -     Press “LESS” 
 
VOID OTHER THAN THE LAST ITEM 

1. Touch the item to highlight it (it will now have a green background) 
2. Press “LESS” 

 
VIEW ITEMS THAT HAVE BEEN BUMPED FROM THE DISPLAY 
      -     Press “UP”, then “DOWN” to scroll back 
 
CLEAR THE ENTIRE SALE 

1. Press “CLEAR” 
2. Press “OK” 

 
IF YOU SCAN A CARD, RING ITEMS, AND THEN NEED TO CLEAR THE ENTIRE SALE 

1. Press “CLEAR”, “OK”, then “EXIT” 
2. Re-enter your workstation # and press “ENTER” 

 
PRINT THE LAST CHECK 
(use this procedure to print a check whenver you do an over-ring, so that it can be cancelled later) 
      -     Press “PRINT PREV” at the top of the screen 
 
PRINT A CHECK THAT WAS NOT PRINTED IMMEDIATELY AFTER THE SALE 
(an over-ring occurred, but more transactions were rung after it) 

1. From the order screen, press “PREV. CHKS”  at the top of the screen 
2. The details from the of the last five check will be displayed, press “MORE” to display additional checks 
3. Press the check number of the check you wish to print 
4. Press “PRINT THE CHECK” 

(Note: only the last 40 checks will display.  For older checks, you must look them up in the back-office.) 
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CORRECT AN OVER-RING (CANCEL CHECK PROCEDURE) 
Examples:   - You ring too many items and finalize the sale 
  - You are ringing a cash sale and accidentally scan a card 
  - You charge one student’s meal to another student’s card 
 

1. Press “PRINT PREV” to print a copy of the check 
2. Before performing the “End of Day” procedure, at any of the terminals, enter the manager number (200) and press 

“FUNCTION”.  Go to the “MANAGER MENU”, and then press “CANCEL CHECK”. 
3. A box will appear that asks for the “Check number”.  Enter in the last four digits of the number on the printed check 

and press “ENTER” (ex.; check #100321-1 would be entered as “0321”, and check #101234-1 would be “1234”) 
4. After a second the payment selection screen will appear to ask if you are cancelling the check to “CASH” or to 

“RECEIVABLES” (student card).  Press “CASH” for a cash transaction.  For a card transaction, press 
“RECEIVABLES”, then either scan the card or enter the account number on the keyboard that appears. 

5. A receipt will print to confirm that the over-ring has been cancelled.  Make sure that the bottom of the receipt has 
the correct payment (i.e. cash or a receivable account). 

 
IF A STUDENT EXCEEDS THEIR BALANCE, BUT THIS IS NOT NOTICED UNTIL AFTER THE SALE IS FINALIZED 
Example:  Student has $2.00 left on their card, but sale is rung for $5.00 

1. A box will display that reads “Transaction refused  Credit = $2.00” 
2. Press “OK” 
3. Press “CASH”, then “ENTER” (this puts the sale into the cash total) 
4. If the student has cash for the sale, take that as payment, and skip the rest of these steps; otherwise, press “PRINT 

PREV” and write the student’s name and account number on this receipt. 
5. Before the End of Day, do a “CANCEL CHECK” for this sale (see above) 
6. When you receive additional funds from the student at a later date, ring the $5.00 (select the items from the printed 

receipt) and charge it to the student’s card. 
(Note: Students should NOT be allowed to continually purchase meals without adding money to their account.  This is only a 
temporary, ideally one-time solution for when the child does not have money.  Parents should be notified to send money so 
that their card will have funds available.) 
 
CHECK A STUDENT’S BALANCE FROM THE TERMINAL 

1. From the “SERVER #:” screen, press “RECEIVABLES” 
2. Scan the student’s card, and a balance will display  (note:  At the grade schools, where a credit balance of $15.00 is 

used, this credit will be included in the balance; so a card with a balance of $45.00 will display as $60.00) 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

WHEN IN DOUBT, PRESS “PRINT PREV.” TO SEE THE LAST TRANSACTION RANG!!! 
THIS WILL TELL YOU HOW MUCH WAS RANG, AND WHICH CARD IT WAS RANG TO. 
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BACK OFFICE OPERATIONS 
 
START THE MAITRE’D BACK-OFFICE PROGRAM 

1. Double click the “Maitre’D Back-Office” icon on the desktop 
2. Enter your password on the keyboard and press the “ENTER” key twice 
3. The program will appear, and a box will pop up over it called the “Fast Access” menu 

 

END OF DAY PROCEDURE 
 
STEP 1) Insert the flash drive into either of the USB ports on the front of the computer.  Wait 5-10 seconds.  A window may   

 pop up; if it does, exit this window. 
STEP 2) Double click the “End of Day” icon on the desktop, then enter your password. 
STEP 3) A box will appear that reads “WARNING: CURRENT OPERATIONS SUSPENDED”, click “OK”. 
STEP 4) After this process completes, another box will appear asking you to save the full system, click “Yes”.  Another box  

 will immediately follow it that says “CHANGES AFTER EOD WILL NOT BE SAVED”, click “OK”.  Once the process    
 completes, another box will display that says “Successful operation”, click “OK”. 

STEP 5) After this process completes, a box will appear for the date selection of the daily report, leave all settings as they  
are and click “OK”.  The “FSC Daily Report” will appear; click on the printer icon up top, then click “OK”.  Close the    
report when you are finished by clicking the “x” in the top right corner. 

 
 
MULTIPLE END OF DAY 
(This must be done after any day off; i.e. on Monday after a weekend, or after a holiday) 

1. Double click the “Mutliple End of Day” icon on the desktop, then enter your password. 
2. A box will appear that says “Bring the system up to today’s date”; click “OK” 
3. “SUCCESSFUL” will display; click “OK” 

 
CHECK THE DATE OF THE LAST “END OF DAY” – (What day is your system on???) 

1. From the Maitre’D Back-Office, click on the “Point of Sale Control” icon 
2. Click on the “View” menu at the top of the screen 
3. Click on “Setup Dates” 
4. The fourth line in this box says “Last Closed Date:”.  This should be yesterday’s date.  If not, perform and “End of 

Day” and a “Multiple End of Day” if needed. 
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ACCOUNT RECEIVABLE (STUDENT CARDS) OPERATIONS 
 
ADD A NEW STUDENT 

1. From the Maitre’D Back-Office Fast Access menu, click on “A/R Customer Setup” and click “Execute” 
2. Click “Add” in the upper right of the box 

(Note: When finding an existing student, you can click either the box that says “Description” or the box that says 
“Code” at the top of the list to arrange the list by name or card number, respectively.  You can then type the name 
of the student or card number (depending on which box you clicked) to go to that student’s account.) 

3. Enter the student’s barcode number in the “CODE” field 
4. Enter the student’s name (last name first, space between names, all capitals) 
5. Only for grade schools: Enter a credit of (either $10.00 or $15.00) in the “CREDIT LIMIT” field 
6. Only for faculty and administration:  Click on the arrow next to “AUTO DISCOUNT” and select “FACULTY DISC” 
7. Click “OK” 

 
ADD PAYMENTS TO A STUDENT’S ACCOUNT 

1. From the Maitre’D Back-Office Fast Access menu, click on “A/R Enter Transaction” and click “Execute” 
2. In the box that appears, click the down arrow to open the drop down list and select the student’s name (this can 

also be done by typing the student’s last name on the keyboard, the selection will change to the name you type) 
3. When the name is selected, click “OK” 
4. Click the “Add” button on the right hand side of the box that appears 
5. Click the arrow next to the “Date” field and click on “Today” at the bottom of the calendar (red circle) 
6. Enter the amount of the payment in the “Amount” field 
7. Enter the number of the check to deposit in the reference field (or “CASH” for a cash payment) 
8. Click on the arrow next to the “Type” field 
9. Select “CREDIT” (do not select “CHECK” or “CHARGE”) 
10. Click “OK” at the bottom of this box 
11. The transaction will appear in the list below the student’s name; click “OK” at the top right corner of this box  
12. In your log book, record the student check; and copy this check, as well as all checks! 

 
VIEW AND PRINT A STUDENT’S HISTORY OF PURCHASES 

1. From the Maitre’D Back-Office main window, click on the “Account Receivable” icon 
2. Click on the “Report” menu at the top of the window 
3. Move the mouse to “FSC >” and another menu will appear; select “Transactions Summary” 
4. In the box that appears, click the arrow next to the “From:” box and select the date to begin with, then click the 

arrow next to the “To:” box and select the date to end with (i.e. the beginning of the school year until now) 
5. On the left hand side of the box, click on “Customers” 
6. On the right hand side of the list of students, click the “Remove All” button 
7. Click and place a checkmark next to the student(s) name(s) for whom you wish to view a transaction history 
8. Click “OK” 
9. The report that appears will display a list of all the transaction dates and the amount that was purchased; click on 

the printer icon at the top, then click “OK” to print the report 
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IF A DEPOSIT HAS BEEN ENTERED MORE THAN ONCE TO A STUDENT’S CARD 
 
Remove the deposit from “A/R Enter Transaction” by selecting it and clicking the “Delete” button to the right.  
 
IF A DEPOSIT HAS BEEN ENTERED FOR THE WRONG AMOUNT OR THE WRONG DAY 
 
Change the deposit  from “A/R Enter Transaction” by selecting it and clicking the “Modify” button to the right. 
 
 

LOST CARD PROCEDURE (4 STEPS) 
 
STEP 1) PRINT REPORT ON STUDENT’S TOTAL CREDITS (DEPOSITS) AND CHARGES 

1. From the Maitre’D Back-Office main window, click on the “Accounts Receivable” icon 
2. Click on the “Report” menu at the top of the screen 
3. Move the mouse to “FSC >” and another menu will appear; select “Receivables (Total)” 
4. In the box that appears, you’ll see a list of the student’s names; click the “Remove All” button to the right, then click 

and place a check mark next to the student(s) name(s) you need to create a new card for, and click “OK” 
5. In the report that appears, click on the arrow up top that says “GO TO LAST PAGE” (right arrow with a vertical line)  
6. At the bottom of this report are displayed the student’s total Credits, then Charges, then their current balance 
7. Click on the printer icon up top, then click “OK” 

 
STEP 2) FLAG LOST CARD AS “INACTIVE” 

1. From the Maitre’D Back-Office Fast Access menu, click on “A/R Customer Setup” and click “Execute” 
2. Double click on the name of the student who has lost their card 
3. In the “Name” field, add a “ -1” (space, hyphen, and number) behind the student’s name if it’s the student’s first 

lost card, add a “ -2” if it’s the student’s second lost card, add a “ -3” if it’s the student’s third lost card, etc.           
(i.e. “John Smith” becomes “John Smith -1” for the first lost card, the second lost card becomes “John Smith -2”, 
and so on) This is done to the card that was lost, not the new card that you are creating!!!  The student’s 
current card should always only contain their name! 

4. Click the “Inactive” check box (lower left corner of the box below the “Phone” field) 
5. Click “OK” 

 
STEP 3) CREATE A NEW CARD 
      -     See “ADD A NEW STUDENT” on the previous page 
 
STEP 4) ENTER STUDENT’S TOTAL CREDITS AND CHARGES ON THE NEW CARD 

1. From the Maitre’D Back-Office Fast Access menu, click on “A/R Enter Transaction” and click “Execute” 
2. Find and select the student’s name in the drop down list and click “OK” 
3. Enter a transaction for BOTH the total amount of credits AND the total amount of charges for the student’s account 

(from the report that you printed in step #1), selecting YESTERDAY’S DATE as the date for the transactions, so 
that they will not be added into your totals for today!  (note: enter deposits as “CREDIT” and enter charges by 
selecting type “CHARGE”) 

4. After you enter both Credits and Charges separately, you will see that the “Balance” field will reflect the balance the 
student previously had on the card that was lost 

5. Click “OK” 
(Note:  for more detailed instructions, see “ADD PAYMENTS TO A STUDENT’S ACCOUNT” on the previous page) 
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BACK OFFICE REPORTS 
 
TO TAKE A “FSC DAILY REPORT” FOR A PREVIOUS DAY 

1. Double click the clock in the lower-right hand corner of the screen (the Windows clock) 
2. In the box that appears, select the date for which you wish to take the FSC Daily Report 

(it is very important to remember to change the date back to today’s date after you are done!) 
3. From the Maitre’D Back-Office main menu, click on the “Account Receivable” icon 
4. Click on the “Report” menu at the top of the window, then move the mouse to “FSC >”.  Another menu will appear, 

select “FSC Daily Report” 
5. In the box that appears, select the day for which you wish to take the report by going to the “Day” folder icon (the 

top selection in the box), then the folder for the year (ex. “2008”), then the folder for the month (ex. “August”), and 
then clicking on the day/date, then click “OK”. 

6. The report that appears will be the daily report for the day you have selected. 
(AGAIN, REMEMBER TO SET YOUR CALENDAR BACK TO TODAY’S DATE FROM STEPS 1 AND 2!!!) 

 
TOTAL OF ALL CARD DEPOSITS, CHARGES, AND BALANCES 

1. From the Maitre’D Back-Office main menu, click on the “Account Receivable” icon 
2. Click on the “Report” menu at the top of the window, then move the mouse to “FSC >”.  Another menu will appear, 

select “Receivables (Total)” (either sorted “by Name” or “by Number”). 
3. In the box that appears, click “OK” 
4. The report that appears will display each students’ total deposits, charges, and balance, along with a grand total of 

all deposits, charges, and balances at the end 
 
CARD TRANSACTIONS AND TOTALS FOR A SPECIFIC DAY OR DAY RANGE 

1. From the Maitre’D Back-Office main menu, click on the “Account Receivable” icon 
2. Click on the “Report” menu at the top of the window, then move the mouse to “FSC >”.  Another menu will appear, 

select “Transactions Summary”. 
3. In the box that appears, click the arrow next to the “From:” box and select the date to begin with, then click the 

arrow next to the “To:” box and select the date to end with (select the same date for one day’s totals, or pick a 
range of dates, or you may leave both of the dates alone to view all transactions), then click “OK” 

4. The report that appears will display each students total deposits, charges, and balance, along with a grand total of 
all deposits, charges, and balances for the dates selected 

 
LOW BALANCE LETTERS (grade schools only) 

1. From the Maitre’D Back-Office main menu, click on the “Account Receivable” icon 
2. Click on the “Report” menu at the top of the window, then move the mouse to “FSC >”.  Another menu will appear, 

select “Low Balance Letters”. 
3. In the box that appears, if you simply click “OK”, a letter will be generated for every child that has a balance of 

$15.00 and below (not including the $10 or $15 credit of your money given to them).  If you need a letter for only 
one child or a few children, click the “Remove All” button to the right, then click and place checkmarks in the boxes 
next to those childrens’ names for which you wish to generate letters, then click “OK”. 
Note: This will include any children that you have entered in the system with a zero balance (you created a 
card, but they did not give you money).  There is no way around this, it is how the formula works for finding 
which accounts have a low balance. 
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MENU ITEMS SETUP 
 
CHANGE THE PRICE AND NAME OF AN ITEM (done from the terminal) 

1. From the “SERVER #:” screen, enter the manager # (200) and press “FUNCTION” 
2. Go to the “MANAGER MENU” and press “PRICE” 
3. You will see the order screen, and the word “PROPERTY” will display on the lower left; this means you are now in 

“price change” mode 
4. Press the item you wish to change 
5. To change the item’s price, press “LUNCH =>”, type in the new price on the number pad, then press “ENTER” 
6. To change the name of the item, first press “ITEM DESCRIPTION”; change the name using the keyboard that 

appears, then hit the return key (the arrow on the right of the keyboard).  This will change the name that will appear 
on the reciept.  Now press “KEY DESCRIPTION” and do the same to change the name that appears on the button 
on the order screen. 

7. When you are finished, press “EXIT” until you have returned to the “SERVER #:“ screen.  If “PROPERTY” still 
shows on the order screen, you need to press exit again. 

 

ADD A NEW ITEM (2 STEPS) 
 
STEP 1) ADD THE ITEM TO THE DATABASE 
(This does not automatically add the new item to the screen, but must be done first) 

1. From the Maitre’D Back-Office main window, click on the “Point of Sale Control” icon 
2. Click on “Items Setup” 
3. In the list of items, find an item that is similar to the item  you are adding (i.e. if you are adding a beverage, find 

another beverage, if you are adding a sandwich, find another sandwich), click on it to highlight it, then click on the 
“Duplicate” button on the right hand side of the screen. 

4. A box will appear with the name of the item you duplicated followed by a number; type the name of the new item in 
it’s place 

5. On the left hand side of the box (white area), click on “Configuration” 
6. Double click on “Lunch” on the right 
7. A box will appear with the price, type the new price in here 
8. Click “OK”, click “OK” again, then click “Close” 

 
STEP 2) ADD THE ITEM TO THE ORDER SCREEN 

1. From the Maitre’D Back-Office main window, click on the “Point of Sale Control” icon 
2. Click on “Preferential screen setup” 
3. Double click on “Default” 
4. Double click on an empty space 
5. Click on the down arrow to the right of “Usage” 
6. Find the item and click on it 
7. Click “OK”, click “Close”, then click “Close” again 

 
OR ADD THE ITEM TO A DROP-DOWN LIST 

1. From “Point of Sale Control”, click on the “Screens” menu up top 
2. Click on “Variable list setup” 
3. Double click on the list to which you wish to add the item 
4. Click on an empty space at the end of the list 
5. Type the name of the item or select it from the drop down list where it says “Item” 
6. Click “OK”, click “OK” again, then click “Close” 
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EXPORT STUDENT BALANCES 
 
These instructions will guide you through getting a file that contains a list of the students’ balances. 
 
STEP 1) EXPORT BALANCES INTO AN EXCEL FILE 

1. Run the “Receivables (Total) by Number” report (see “TOTAL OF ALL CARD DEPOSITS, CHARGES, AND 
BALANCES” on pg. 7 for instructions on how to take this report). 

2. Once the report is displayed on the screen, click on the “File” menu up top 
3. Click on “Export…” 
4. In the box that appears, in the box labeled “Format” (right hand side), click the drop down list 
5. From the list, select “Excel (Data only)” 
6. On the left hand side (in the white area), click on “Destination” 
7. On the right hand side, click the “Browse…” button 
8. In this box, you will select where you want to save the file.  This may be different at each location, depending on 

how you will be working with the school to post the balances online.  We will cover this on an individual basis. 
9. Once you have selected the location to save the file, click on “Open” 
10. Back at the box labeled “Export Report”, click on “OK” 
11. A window will appear in the top-left corner letting you know that it is exporting the report 
12. Once the window disappears, click the “x” in the top right corner to close the report 

 
STEP 2) EDIT THE EXCEL FILE 

1. Open the Excel file that you have just exported (again, this will differ depending on where you saved it) 
2. Every column is labeled at the top with a letter; click on “B”, and everything in column B will be selected (the 

students’ names should now all be highlighted) 
3. Hold the “Shift” key on the keyboard, then click on the letter “E” at the top; everything from the “Customer”, 

“CHEQUE”, “CREDIT”, and “CHARGE” columns should now be highlighted 
4. Right click anywhere in the highlighted area 
5. In the menu that appears, click “Delete” 
6. Click on the “File” menu up top 
7. Click on “Save” 
8. Close Excel by clicking on the “x” in the top right corner 

 
You now have an Excel file that contains only a list of the students’ account numbers followed by their balances, which can 
be given to the schools in order to post them online.  Again, getting this list posted online may differ from school to school, 
and we will be working with each location on how this will process will work. 
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TROUBLESHOOTING 
 

TERMINALS NOT FUNCTIONING 
 
1) TERMINAL SCREEN IS BLANK (BLACK) 
 
Touch the screen.  Does the image appear? 
 
 YES: The screen was in power-saver mode.  If you do not want this to happen, Cash Control can change this  
  setting for you. 
 
 NO: Hold the the power button down on the terminal for 10 seconds.  Wait another 5 seconds, then press the  
  power button again.  Does the terminal start up? 
 
   YES: As long as the terminal starts up properly, everything should be okay; unless this continues 
    to happen.  If it does, contact Cash Control. 
 
   NO: Make sure that the power cord is plugged into the wall, and plugged in to the terminal  
    correctly.  If you check all the power connections and it still does not work, call Cash  
    Control for tech support. 
 
2) TERMINAL SCREEN IS WHITE AND/OR HAS AN ERROR BOX IN THE MIDDLE OF THE SCREEN -  ERROR 9901 
 
Is your back office PC turned on? 
 
 NO:       If the back office PC is not on, the terminals will not function.  Turn it on, and once it boots up, the terminals 
  should begin to work. 
 
 YES:     A) In your office, somewhere near the PC, there is small box that connects all of the data cables from the  
  PC and the terminals which is called a SWITCH, or HUB.  It is slightly larger than your hand, has a lot of  
  lights on it, and has eight connections on the back of it.  Find this box and unplug the small round black  
  connector from the back of it (the power cable), wait 5 seconds, then plug it back in. 
 
  B) On the back office PC, next to the clock on the Start menu (lower right hand corner of the screen), there  
  should be an icon that looks like a gray box with a red and a green light on it.  Is this box not there, or do  
  you instead see a box with a red X over it? 
 
   NO ICON: Open the Maitre’D Back-Office and click on the Server Control icon.  Go to the “FILE”  
        menu (up top), and click on “Start server”. 
 
   ICON WITH A RED X: Call Cash Control for tech support. 
 
3) TERMINAL IS FROZEN OR LOCKED UP 
 
 A) Make sure that receipt printer is not out of paper. 
 
 B) Hold the power switch down until the computer turns off, wait 5 seconds, then push the power switch again. 
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BACK OFFICE PC NOT FUNCTIONING 

 
1) THERE IS A LIGHT ON THE PC, BUT THE COMPUTER SCREEN IS BLANK 
 
Hit the spacebar on the keyboard. Did the screen turn on? 
 
 YES: The screen was simply in “suspend” mode (like a screen saver) 
 
 NO:  Make sure that the monitor is turned on.  If it is, there will be a light near the power button just below the 
 screen.  If the monitor is turned on, and the light on the PC is on, but you still have a blank screen, hold the power 
 button on the PC in until the lights on the PC turn off, wait 5 seconds, then push the power button again.  The PC 
 should begin to boot up. 
 
2) THERE ARE NO LIGHTS ON THE PC AND THE POWER BUTTON DOES NOT WORK 
 
Unplug the power cable from the wall and the back of the PC.  Make sure that the wall outlet you are using is working 
correctly (plug something else into it, such as a lamp).  Plug the cable back into the back of the PC, and back into the wall, 
and try to turn on the PC again. 
 
3) COMPUTER IS FROZEN OR LOCKED UP 
 
Hold the power button on the PC in until the lights on the PC turn off, wait 5 seconds, then push the power button again.  
The PC should begin to boot up. 
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END OF DAY BALANCING ISSUES 
 
DAILY FIGURES ARE “$0.00” ON THE “FSC DAILY REPORT” 
 
An “End of Day” has been missed, and Maitre’D is not caught up to the current calendar day.  See below.  
 
SALES FIGURES DO NOT BALANCE, OR “END OF DAY” IS NOT ON THE RIGHT DATE 
 
Open the Maitre’D Back-Office program and click on the “Point Of Sale Control” icon from .  Go to the “VIEW” menu (up 
top), and click on “Setup Dates”.  There is a line that says “Last Closing Date:”.  This date should be yesterday’s date.  If 
not, an “End of Day” was not performed, or, if this is a Monday or the first day back after a break, a “Multiple End of Day” 
was not done.  You may do a Multiple End of Day at this time if you have not rang any sales, but if you have, you will need 
to do a Multiple End of Day the next day before you ring any sales.  Tomorrow’s figures should then balance. 
 
CARD DEPOSITS ON THE DAILY REPORT DO NOT MATCH ACTUAL DEPOSITS 
 
On the desktop, click the “Receivables (Daily)” icon.  This report will display a list of all the students accounts, and any 
deposits made for today will be in the “Credits” column.  If your actual deposits for today do not match your total credits on 
today’s  daily report, then you should search through the “Transactions Summary” report for today for any deposits to 
students’ accounts that may have been made in error. 
 
CASH SALES IN THE REPORT DO NOT MATCH ACTUAL CASH COLLECTED 
 
Remember to perform a “Cancel Check” procedure for every over-ring that happens during the day before you do the End of 
Day.  If you find that there was an over-ring that was not cancelled before the end of day, the only way to account for this is 
to manually adjust it off of the total (i.e. write a note on your paperwork for that day).  If you do not find an over-ring that was 
not taken care of, and your cash still does not balance, perhaps the cashiers missed an over-ring, or forgot to ring some 
items.  If the cashier does not catch their own errors, there is no way to account for this.  Maitre’D only records  what is 
entered into it. 
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OTHER ISSUES & NOTES 
 
This section will be updated with any further notes that are needed as time goes by.  Please also use this section to write 
any of your own notes instead of writing them in the previous pages of the manual, as we will be revising and replacing 
these pages in time as well.  If you make notes on the other pages, you may have to throw them out later when we update.  
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